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LEIA COM ATENCAO AS INSTRUCOES ABAIXO.

Confira atentamente se os seus dados pessoais e os dados identificadores do cargolespecializagio para o qual
vocé concorre, transcritos acima, estdo corretos e coincidem com o que esta registrado em sua folha de
respostas. Confira também o seu nome e 0 nome do cargo/especializagdo para o qual vocé concorre em cada
pagina numerada deste caderno de provas. Em seguida, verifique se ele contém a quantidade de itens indicada em
sua folha de respostas, correspondentes as provas objetivas. Caso o caderno esteja incompleto, tenha qualquer
defeito, ou apresente divergéncia quanto aos seus dados pessoais ou quanto aos dados identificadores do
cargo/especializacio para o qual vocé concorre, solicite ao fiscal de sala mais préximo que tome as providéncias cabiveis,
pois ndo sere aceitas reclamagcdes posteriores nesse sentido.

Quando autorizado pelo chefe de sala, no momento da identificacdo, escreva, no espago apropriado da folha de
respostas, com a sua caligrafia usual, a seguinte frase:

O ser humano cria a propria saude ou a propria doenga.

Conforme previsto em edital, o descumprimento dessa instrugdo implicard a anulacdo das suas provas e a sua eliminacéo
do concurso.

Nao se comunique com ouiros candidatos nem se fevante sem autorizagfo de fiscal de sala.

Na duracéo das provas, esta incluido o tempo destinado a identificagdo — que sera feita no decorrer das provas — € ao
preenchimento da folha de respostas.

Ao terminar as provas, chame o fiscal de sala mais proximo, devolva-the a sua fotha de respostas e deixe o local de provas.

Adesobediéncia a qualquer uma das determinacBes constantes em edital, no presente caderno ou na folha de respostas
podera implicar a anulagao das suas provas.

OBSERVAGOES

.

.

.

Nao seréo objeto de conhecimento recursos em desacordo com o estabelecido emedital.
InformagBes adicionais: telefone O(XX}61 3448-0100; Internet - www.cespe.unb.br.
E permitida a reproducdo deste material apenas para fins didéticos, desde qus citada a fonte.
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De acordo com o comando a que cada um dos itens a seguir se refira, marque, na folha de respostas, para cada item: o campo designado
com o codigo C, caso julgue o item CERTO; ou o campo designado com o codigo E, caso julgue o item ERRADO. Para as devidas
marcacdes, use a folha de respostas, unico documento valido para a corre¢éo das suas provas.

Texto para os itens de 1 a 17

22

25

28

31

34

37

40

43

A violéncia instalada nas grandes cidades levou
muitos brasileiros a fazer o caminho oposto ao dos
antepassados. Em busca de melhor qualidade de vida, eles
abandonaram as capitais e os centros urbanos. Instalaram-se em
urbes do interior que, ao longo dos Ultimos anos, atrairam
investimentos e ampliaram o mercado de trabalho. Ali, os
novos moradores poderiam usufruir do conforto urbano aliado
a tranquilidade decorrente da garantia de seguranga.

Levantamento do Mapa da Violéncia mostrou que o
cenario pacifico ficou no passado. Divulgado no dia 30 de
margo pelo Instituto Sangari, o documento prova que a
criminalidade mudou de enderego. Migrou das capitais e
regides metropolitanas para o interior. Em 10 anos, cresceu o
namero de homicidios. Em 1997, a média era de 13,5
assassinatos para cada grupo de 100 mil pessoas. Em 2007, a
cifra saltou para 18,5.

Mais: os dados reforgam tendéncias que vém causando
crescente apreensdo as autoridades atentas a evolugdo do perfil
da violéncia no pafs. Um deles: aumenta o namero de
homicidios entre jovens. Em 1980, eram 30 casos para cada
100 mil habitantes. Em 2007, nada menos que 50,1. Outro:
homens sdo vitimas preferenciais — 90% das ocorréncias.
Mais uma: os negros lideram o ranque dos mortos —
incremento de 21% em relagdo as estatisticas dos periodos
anteriores.

As informagdes do Mapa da Violéncia permitem
extrair conclusdes e sugerir medidas. “O sapo”, escreveu
Guimardes Rosa, “ndo salta por boniteza, mas porém por
precisdo”. O mesmo ocorre com a bandidagem. Criminosos
buscaram novos abrigos porque os antigos ndo mais lhes
oferecem as condigSes de que precisam. O Plano Nacional de
Seguranga Puablica e o Fundo Nacional de Seguranga
implementaram eficazes dificultaram a

acoes que

movimentagdo do crime organizado. Entre elas, o
aparelhamento dos sistemas de seguranca publica nos grandes
conglomerados.

O combate a malfeitores ndo se deve restringir as
metrdpoles. Deve, para atingir o fim a que se propde —
erradicar o crime ou reduzir os casos a niveis civilizados —,
estender a guerra aos novos territorios. Além de medidas
repressivas, impdem-se iniciativas preventivas. Sem isso, os
novos mapas a serem divulgados nos proximos anos mostraréo
atroca de seis por meia dazia. Em vez de diminuir a ocorréncia

nacional do crime, indicarfo apenas a mudanga de enderego.

Crime muda de endereco. /n: Correio

Braziliense, 1.°/4/2010, p. 22 (com adaptagdes)

Julgue os itens que se seguem, relativos as ideias do texto.

De acordo com o texto, cidades pequenas sdo locais atraentes
para investidores e oferecem amplo mercado de trabalho.

O nivel de criminalidade cresceu nas cidades interioranas em
virtude das dificuldades encontradas, nas grandes cidades,
pelos transgressores da lei.

De um lado, o cendrio atual da violéncia tende a piorar a
vulnerabilidade de trés grupos sociais: o dos jovens, o dos
homens e o dos negros; de outro lado, esse fendémeno deve
levar a diminuic¢do de atos violentos contra as mulheres.

O texto mostra que o crime organizado nas metropoles
diminuiu desde que o Plano Nacional de Seguranca Publica e
o Fundo Nacional de Seguranga puseram em pratica medidas
coercivas.

Segundo o texto, impedir os crimes previamente é uma medida,
no minimo, tdo necessaria quanto repreender 0s criminosos.

Com relagdo a estrutura do texto, julgue os proximos itens.

Com excecio de “atrairam” (£.5) e de “ampliaram” (£.6), todas
as formas verbais do primeiro pardgrafo fazem referéncia a
“muitos brasileiros” ({.2).

Os termos “Um deles” (0.19) e “Outro” (£.21) referem-se a
“os dados” (¢.17).

Os termos “antigos” (0.30) e “grandes conglomerados”
(0.35-36) retomam a ideia de “as capitais ¢ 0s centros
urbanos” (0.4).

O trecho “estender a guerra aos novos territorios” (£.40) pode
ser alterado para estender os novos territorios a guerra sem
se prejudicar a corre¢fio gramatical e o sentido original do
periodo.

Com relagdo & pontuagdo empregada no texto, julgue os itens

seguintes.

10

Na linha 3, a substituigdo do ponto que finda o primeiro
periodo por dois-pontos mantém a corregdo gramatical do
texto, desde que se altere a inicial de “Em” para mintscula.

Na linha 5, do ponto de vista gramatical, seria correto o
deslocamento da virgula que sucede a palavra “que” para
imediatamente apds o vocabulo “interior”.

A corregdio gramatical do texto seria mantida caso o trecho
“Divulgado no dia 30 de margo pelo Instituto Sangari”
(0.10-11) fosse deslocado para depois da expressdo
“o documento” (£.11) da seguinte forma: O documento

divulgado no dia 30 de margo pelo Instituto Sangari.

Cargo 12: Analista - Especializagao: Programacao Visual
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Com referéncia & concordédncia e & regéncia verbal e nominal
empregadas no texto, julgue os itens a seguir.

13 Nalinha 17, a locugdio “vém causando” apresenta concordancia
de nimero com o seu respectivo sujeito, “os dados”.

14 No trecho “vém causando crescente apreensdo as autoridades”
(0.17-18), a ocorréncia do acento grave deve-se a regéncia de
“apreensdo”.

15  Em “autoridades atentas a evolugdo do perfil da violéncia no
pais” ({.18-19), o termo “a” poderia ser substituido, sem prejuizo
gramatical ou de sentido para o texto, por para a.

Com referéncia ao vocabulario do texto e a ortografia, julgue os itens
subsequentes.

16 No texto, a expressdo ‘por preciso’ (0.28-29) apresenta sentido
equivalente a com perfeicio.

17 A substitui¢do do vocabulo “malfeitores” (0.37) por celerados
mantém o sentido do texto.

Julgue os itens seguintes, relativos a redag@o de correspondéncias
oficiais.

18 Os principios que regem a redacfio de correspondéncias oficiais
favorecem a existéncia de uma unica interpretagdo para o texto
do expediente, assim como asseguram impessoalidade e
uniformidade no trato dos assuntos concernentes aos 6rgdos
governamentais.

19 O nivel de linguagem utilizado em atos e expedientes oficiais
encontra justificativa no seu carater publico e no fim a que eles se
destinam, além da obrigatoriedade de que sejam inteligiveis para
qualquer publico.

20 Um texto de redacdo oficial deve ser redigido com vistas a evitar
a prolixidade.

frequéncia

quantidade de acessos (x 1.000)

Certa empresa, em determinado més, realizou levantamento acerca da
quantidade didria de acessos simultdneos ao seu sistema, cujo
resultado ¢ mostrado na figura acima. A partir das informacdes
apresentadas nessa figura, e considerando que a distribuicdo da
quantidade didria de acessos simultdneos € representada pela
varidvel X, julgue os itens que se seguem.

21 A quantidade de 6 mil acessos simultdneos por dia representa a
moda de X.

22 O més em que esse levantamento foi realizado possui mais de
30 dias.

23 A quantidade de 2.000 acessos simultdneos didrios representa o
primeiro quartil da distribuicdo X.

24 E correto classificar a variavel X como uma varidvel quantitativa
ordinal.

25 A mediana amostral de X ¢ igual a 3.500.

26 O coeficiente de variagdo de Pearson da distribuigdio X ¢ superior
a 50%.

Certa empresa possui dispositivos para evitar que seu sistema de
informacdo seja invadido por pessoas nfio autorizadas a acesséd-
lo. Apesar disso, para cada tentativa de invasdo, a probabilidade
de sucesso ¢ igual a 0,01. Sucesso € o evento que representa a
situagdo em que o sistema ¢ invadido. A partir dessas
informagdes, julgue os itens a seguir.

27 Considerando ntentativas independentes de invasdo, em que
n é um numero fixo tal que » > 100, a probabilidade de
haver um tnico sucesso é inferior a 0,99"" '

28 Considerando que o nimero de sucessos em 500 tentativas
independentes de invasdo seja representado por uma
variavel aleatdria discreta W e que Y'=3W - 10, os valores
esperados de X e de Y sdo iguais a 5.

29 Caso o total didrio de tentativas de invasfo seja uma
varidvel aleatoria representada por uma distribuicdo de
Poisson com média igual a 100, o total didrio de sucessos
seguird uma distribuicdo de Poisson com média e desvio
padrdo iguais a 1.

30 Considerando que uma sequéncia de tentativas
independentes de invasdo ocorra, e que essas tentativas
cessem quando héd o primeiro sucesso, entdo a distribui¢do
do ntimero de tentativas independentes até a ocorréncia do
primeiro sucesso seguird uma distribuigdo geométrica com
desvio padrdo inferior a 95.

| RASCUNHO ! |
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Para os itens de 31 a 38, serdo consideradas como
proposi¢des apenas as sentengas declarativas, que mais facilmente séo
julgadas como verdadeiras — V — ou falsas — F —, deixando de
lado as sentengas interrogativas, exclamativas, imperativas e outras.
As proposigdes serdo representadas por letras maitsculas do alfabeto:
A, B, C etc. Para a formagfo de novas proposi¢des, denominadas
proposigdes compostas, a partir de outras, usam-se os conectivos “e”,
“ou”, “se ..., entdo” e “se e somente se”, ¢ 0 modificador “ndo”, ou
“ndo é verdade que”, simbolizados, respectivamente, por: A\, V, =, <>
e —. Dessa forma, AAB € lido como “A ¢ B”; AVB ¢ lido como “A ou
B”; A—B ¢ lido como “se A, entdo B”; A <= B é lido como “A se e
somente se B”, significando, nesse caso, que A—~B e B—A; ~A ¢ lido
como “ndo A”. Uma proposigio é simples quando, em sua formulagéo,
ndo se emprega nenhum dos conectivos.

A cada proposigdo supde-se associado um dos julgamentos
V ou F, que se excluem. Para associar esses valores V ou F as
proposigdes compostas, sdo usadas como critério as tabelas-verdades,
como a seguir.

A | B | A AB [A>B |AcB | A
\4 \4 \4 \4

\4 \4 F
\Y% F F \% F F F
F v F v v F v
F F F F \ \ \

As proposi¢des em que a tabela-verdade contém apenas V sio
denominadas tautologias, ou logicamente verdadeiras. Se a tabela-
verdade contiver apenas F, a proposigdo ¢ logicamente falsa.

Duas proposi¢des A e B sdo equivalentes se suas tabelas-
verdades forem iguais.

Tendo como referéncia as informagdes apresentadas, julgue os itens
seguintes.

31 A proposig8o “Néo precisa mais capturar nem digitar o codigo de
barras” pode ser, simbolicamente, escrita como AAB, em que
A ¢ a proposigio “N&o precisa mais capturar o codigo de barras™
¢ B é a proposicio “Nao precisa mais digitar o codigo de barras”.
32 As proposi¢des “Néo precisa mais capturar nem digitar o codigo

de barras” e “N&o precisa mais capturar ou digitar o codigo de
barras” sdo equivalentes.

33 Considerando todas as possibilidades de julgamento V ou F das
proposi¢des simples que formam a proposicdo “Se Pedro for
aprovado no concurso, entdo ele comprara uma bicicleta”, é
correto afirmar que ha apenas uma possibilidade de essa
proposigéo ser verdadeira.

34 Considerando todas as possibilidades de julgamento V ou F das
proposi¢cdes simples que formam a proposi¢do “O SERPRO
processara as folhas de pagamento se e somente se seus
servidores estiverem treinados para isso”, é correto afirmar que
ha apenas uma possibilidade de essa proposi¢do ser julgada
como V.

35 As proposi¢des AAB—AVB e AVB—AAB sfo, ambas,
tautologias.

—1

x
36  Considere M = [
1 x

} uma matriz em que x pode assumir

qualquer valor real. Nesse caso, é correto afirmar que a
proposigdo “Para algum numero real x, a matriz M nfo sera
inversivel” € uma proposi¢fo verdadeira.

37 Considere a seguinte proposicdio: “x, y e z sdo numeros reais
tais que x + y + z =1 e 2x + y + z = 0”. Nesse caso, se
essa proposicdo for V, entdo serd V também a seguinte
proposicdo: “x=-1ey+z=2"

RASCUNHO
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Uma afirmacio formada por um niimero finito de proposicdes
Ay, A, ..., A,, que tem como consequéncia outra proposicdo, B, ¢

denominada argumento. As proposi¢des A, A,, .., A, sdo as

H
premissas, ¢ B é a conclusdo.

Se, em um argumento, a conclusio for verdadeira sempre que
todas as premissas forem verdadeiras, entdo o argumento ¢

denominado argumento valido.
Tendo como base essas informagdes, julgue o item abaixo.
38 O argumento formado pelas premissas

A, A, A=A A, A= A~ A, e pela conclusdo
B = A,AA, ¢ valido.

Os diagramas logicos, também denominados diagramas de Euler-
Venn, sdo utilizados como auxiliares na solugdio de problemas

envolvendo conjuntos. Sfo trés os diagramas basicos.

: indica que um conjunto esta
estritamente contido em outro.

. 0s conjuntos tém alguns
elementos em comum,
mas nao todos.

. n&o ha elementos comuns
entre os conjuntos.

Com base nessas informagdes, julgue os itens a seguir.

39 Considere os conjuntos dos politicos, dos advogados e dos
catdlicos. Nesse caso, o diagrama seguinte pode ser usado para

descrever a relagfio entre esses conjuntos.

40 No Brasil, a relacfio entre eleitores, analfabetos e juizes pode ser

representada pelo seguinte diagrama.

RASCUNHO
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This text refers to items from 41 to 50

1

10

13

16

19

22

25

The Capability Maturity Model (CMM) and the more
recent CMM Integrated have initiated a new discipline of
engineering management that plays a dominant role in software
practice and research. The literature offers a number of successful
cases of how software firms adopted these models and the CMMs
do indeed offer many useful recommendations for how to
systematically assess and improve software operations. The
CMMs are, however, rooted in the ideal of a rational, control-
centered culture for software development, and although other
software process improvement (SPI) approaches have been
suggested, they do not differ from the CMMs when it comes to
underlying values. It is therefore not surprising that most software
firms struggle to take advantage of the potential benefits of SPI as
they adopt this technology into the complex and dynamic realities
of their day-to-day operations.

For small software firms, it is particularly challenging to
adopt SPI technology because the dominating approaches to SPI
target large organizations; there are few resources available for
improvement in small software firms; it is by no means trivial
tailoring SPI knowledge to their needs; and, because it normally
takes several complex and expensive initiatives to reach new
maturity levels. These challenges combined with sensitivity to
highly dynamic environments require small software firms to seek
alternative approaches to exploit the potential benefits of SPI
technology.

Internet: <www palgrave-journals.com> (adapted)

According to the text it is correct to assert that

41 the Capability Maturity Model is likely to become the most
recent integrated discipline of engineering management.

42 software firms have adopted CMMs successfully.

43 SPI technology is particularly suitable for small software

firms.

44 the CMMs are quite unlike other software process

improvement approaches in terms of their basic values.

Based on the linguistic structures of the text, judge the
following items.

45 “indeed” ({.6) can be correctly replaced by in addition to.
46 “although” (0.9) is synonymous with even though.

47 “struggle” (0.13) means to make a determined effort.

48 “by no means” ({.19) is the same as otherwise.

49 the verb to tailor (0.20) is synonymous with to adapt.

50 “seek” (£.23) can be correctly replaced by mix.

RASCUNHO
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A dindmica que sustenta os processos projetual e tedrico
da atividade do design ¢ embasada na dialética da forma e da
fun¢fio, que se expressa nas qualidades de beleza e eficiéncia.
Assim, um objeto qualquer de design, seja ele um produto industrial
ou uma pega de comunicagdo visual, para ser completo, deve ser
bonito e funcionar bem. Interessantemente, funcionar bem ¢
também uma forma de beleza, considerando que o mau
funcionamento de um objeto € algo que incomoda e interfere
negativamente na produc@o, nos processos e nas pessoas.

Eficiéncia, bom funcionamento e precisdo isoladamente
n#o garantem a determinado produto ou pega de comunicagéo o seu
completo desempenho; design €, antes de qualquer coisa, uma
forma de arte que apresenta os aspectos estéticos, plasticos e
graficos de um produto, que, para ser bom, deve funcionar bem, ser
bonito e agradével.

Beleza relaciona-se com o apelo sensorial dos objetos e
das imagens e tem por fungdo chamar a atengfio das pessoas por
meio de um processo de comunicagdo visual em que qualidades
formais, simbdlicas, performaticas ¢ informativas interagem.

Tendo como referéncia o texto acima, e considerando a
multiplicidade de aspectos que ele evoca, julgue os itens a seguir.

§1 Eficiéncia e beleza sdo igualmente importantes no design.
§2 Para ser cult, um produto grafico nfo deve ser funcional.

§3 O projeto grafico de um livro a respeito de sistemas
computacionais ndo deve ter necessariamente preocupagdo
com a estética.

54 Em um cartaz de divulgag¢io de um espeticulo musical, as
qualidades estéticas e funcionais devem estar harmonizadas.

55 Na tipografia, disciplina fundamental do design grafico,
atributos como legibilidade, conforto de leitura e visibilidade
estdo diretamente relacionados a aspectos estéticos do design.

56 O campo do design relacionado & arquitetura de informagéo
objetiva promover maior acessibilidade aos usudrios da rede
mundial de computadores em geral, em uma clara manifestagéo
do carater funcionalista do design.

O design grafico, também denominado programagio
visual, é uma atividade de design associada & comunicagéo social,
que se manifesta na forma visual e, as vezes, audiovisual. A
dialética da forma e fungdo define também a atividade do design
grafico. Entretanto, como manifestagdo da comunicaggo, o design
grafico estd impregnado de elementos especificos que o distinguem
das demais atividades do design, fruto da unido da semantica ¢ da
estética, ou seja, da unido da palavra ¢ da imagem. Para se
estabelecer umarelagfo legitima de comunicagfo visual pelo design
gréfico, trés principios sdo fundamentais: informar, identificar e
persuadir.

E importante ressaltar o cardter onipresente desses
principios, pois eles coexistem, em maior ou menor grau, em toda
e qualquer peca de comunicacéio visual, variando de acordo com o
tema e a natureza de cada projeto.

Tendo o texto acima como referéncia inicial, julgue os itens de
57 a 65, relativos aos fundamentos do design gréfico.

57 Considerando os trés principios citados no texto, € correto
afirmar que informar constitui elemento primordial na
elaboragfio de um infografico para um jornal diario.

58 Um calendario de cardter publicitdrio tem a fungfio principal de
identificar o patrocinador.

59 A persuasfo ¢ uma forma licita de ludibriar o leitor de uma
peca grafica.

60 Em um livro essencialmente de texto, ou em um livro
composto de imagens, o design grafico deve-se basear no
conceito de invisibilidade, ou seja, de que o design deve deixar
transparecer o contetdo da publicagdo.

61 As ilustragdes, de modo geral, possuem carater estritamente
persuasivo.

62 O rotulo de um produto na géndola de um supermercado deve
conter, de forma equilibrada, os trés principios fundamentais
do design, pois ele identifica o produto, fornece informacdes
diversas e seduz o consumidor.

63 Texto e imagem s@o componentes fundamentais a pratica do
design gréfico.

64 O cartaz, seja ele publicitario, social ou cultural, apesar de ser
uma importante peca grafica de comunicacdo visual, nfo
permite grande expressividade grafica pelo uso da imagem.

66 O termo design grafico refere-se & profissio dos
comunicadores visuais, também denominada de programagio
visual, em que a palavra grafico tem o significado primordial
associado a arte de reproduzir por tipografia, gravura e
estereotipia, entre outros meios.

Os conceitos de design grafico sfo colocados a prova no exercicio
cotidiano do designer grafico, em que um conjunto de habilidades
¢ necessario para a pratica profissional, entre elas o desenho, a
fotografia, a reproducéio grafica, os sistemas de cor, a tipografia e
a composi¢do visual. Com relagdo aos elementos envolvidos no
exercicio cotidiano do design grafico, julgue os itens subsequentes.

66 As cores primarias aditivas s8o o vermelho, o verde € o azul,
e servem de base ao sistema RGB utilizado nos monitores e
televisores.

67 As cores ciano, magenta e amarelo sdo denominadas de cores
primadrias subtrativas porque sdo obtidas a partir da retirada de
um dos filtros das cores aditivas.

68 A linguagem visual no design editorial de uma publicagio
impressa ¢ a mesma que em uma publicagfio na Internet.

69 No Brasil, os cartazes sdo comumente impressos em meia-
folha do formato BB, ou seja, em folhas de papel de
48 ¢cm x 66 cm.

70  Aplicativos graficos como o Adobe Illustrator sdo apropriados
para a elaboragéo de publicagdes como livros e livretos.

71 Uma imagem de tom continuo, como uma foto em
preto-e-branco, é reproduzida na impressdo ofsete pelo uso de
reticulas de meio-tom.
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Com referéncia aos cartazes acima, julgue os itens a seguir.

72 O cartaz da figura II caracteriza-se por um design tipografico que harmoniza expressividade e legibilidade.
73 No cartaz I, a tipografia manual e a ilustragfo interagem de forma expressiva.

74 Dacomposigdo simétrica e centralizada do cartaz IV e da leitura de seus elementos visuais, ¢ correto afirmar que o objetivo principal
do cartaz ¢ evidenciar o destino da viagem transatlantica.

75 Emtodos os cartazes, a ilustragio tem uma fungfo protagonistano leiaute, e a tipografia € predominantemente de carater informativo.

-7 -
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O uso de software livre incorporou ao vocabulario dos designers e profissionais das artes graficas novas extensdes de arquivos.

Considerando os sofiwares livres GIMP, Inkscape e Scribus, julgue os proximos itens.

76

77

78

79

A extensdo de arquivo .svg (scalable vector graphics) é usada para publicar imagens vetoriais na web.
O software GIMP ndo salva vetores como arquivos .svg.
O Inkscape gera arquivos com extensfo .svg, o que permite o intercdmbio de objetos com o GIMP.

A extensdo de arquivo .sht é a mais indicada para salvar imagens que serdo utilizadas em uma diagramagio de pagina no Scribus.

Em relacdo as figuras acima e ao uso de comandos e ferramentas do software livre Inkscape, julgue os seguintes itens.

80

81

82

83

A figura I, que representa a unido entre um quadrado e uma circunferéncia, pode ser obtida utilizando-se o comando path>union

apos a selegdo dos dois objetos.
A figura I pode ser obtida utilizando-se os comandos Path>Combine, Path>Difference ou ainda o Path>Exclusion.
A figura I1I pode ser obtida utilizando-se o comando Path>Intersection.

Para apresentar o efeito blur, a figura IV precisa ser convertida em bitmap por meio do comando Path>Trace bitmap.

s e

Ee

gy, %

Considerando a figura acima apresentada, julgue os itens a seguir, referentes ao software Inkscape.

84

85

86

A cor aplicada a um objeto, composta de 50% de C, 100% de M, 0 % de Y ¢ 0% de K, corresponde a uma tonalidade entre o azul

¢ 0 magenta.
No campo Blur, é possivel configurar o esfumagado nas bordas de uma figura.

Alpha e Opacity possuem a mesma fungdo de tornar um objeto transparente.
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Db g ek

Fit Canwas to Layers

Brint Sixe...

Considerando a figura acima, em que os espagos retangulares em
branco presentes no menu do sofiware GIMP formam a sequéncia
image>mode>decompose, julgue os itens subsequentes.

87 A opgdo decompose permite extrair os canais de uma imagem,
incluindo a opgdo CMYK.
88 A decomposicdo da imagem gera telas coloridas.

89 Cada uma das telas originadas no Decompose>CMYK
corresponde a um canal de cor em RGB.

Com referéncia a imagem acima apresentada, que mostra uma
janela do GIMP, e a esse sofiware, julgue os itens de 90 a 93.

90 A figura acima mostra a fusdio de duas imagens. E possivel
alcangar esse resultado por meio do comando menu
Filter>Combine>Depth merge.

91 No GIMP, foi possivel conseguir a fusio das imagens

utilizando o comando Calculations.

92 A imagem apresentada ndo deve ser utilizada em um sitio, ja
que as suas dimensdes, assim como o tamanho do arquivo, sdo

maiores que as comumente utilizadas na Web.

93 Antes de salvar a versdo final da imagem, € necessario unir as
duas camadas que a compdem por meio do comando

Layer>Flatten image.

Para diagramar um documento, uma revista ou mesmo um livro,
uma opg¢do em software livre reconhecida pelos profissionais de
design grafico € o Scribus, também conhecido como scribus open
source desktop publishing. A respeito desse software, julgue os

itens que se seguem.

94  S#o conhecidos como desktop publishing (DTP) os sofiwares
que possuem ferramentas para organizagdo de textos, que
dialogam com sofiware de tratamento de imagem e
principalmente que oferecem opgdes de saida e finalizagdo de

arquivos.

95 Formularios, livros e textos trabalhados no Scribus podem ser

convertidos em arquivos .pdf.

96 A linguagem JavaScript é importante para configuracéio de

formulérios criados no Scribus e que serdo publicados na web.

97 A criacfo de uma pagina mestra ¢ importante para que as
caracteristicas gerais do documento possam ser definidas para
toda a sua extensdo. Apesar disso, no Scribus ¢ impossivel

converter uma pagina qualquer em péagina mestra.

Uma instituigdo disponibilizou em 1998 uma série de formularios
online para seus clientes. Considerando que esses formularios ainda
sejam atuais, julgue os itens a seguir, que abordam as dificuldades

para baixa-los pela Internet.

98 Um arquivo com a extensdo .tif ndo seria o mais indicado, pois
ele armazena grande quantidade de informag8o, e o tamanho
do arquivo aumentaria o tempo de transferéncia dessas

informagdes na rede.

99 Devido a largura de banda disponivel em 1998, de 14 Kbps,
para a maioria da populagfo, os arquivos feitos em software de
diagramagdo podiam ser facilmente acessados e modificados

pelos usuarios.

100 A extensdo .ps ndo deveria ser utilizada pelo grande publico,
pois essa extensdo, ainda hoje, requer sofiware especificos,

disponiveis apenas em graficas, editoras e locais similares.
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Ferramenta de fontes
Typekit
Tipografia online, finalmente.

Os designers ha muito reclamam do estado da tipografia
na Web. E eles estdio certos, afinal de contas é muito limitador
contar com apenas um punhado de fontes de sistema comuns a
todos.

Felizmente a adog¢do da fag @font-face entre o0s
navegadores atuais e a chegada do Typekit prometem mudar a
situagdo.

O Typekit hospeda as fontes em seus servidores, e os
associados carregam os arquivos com um simples codigo em
JavaScript. Entdo € possivel trabalhar com novas fontes
normalmente, com a diferenga de que ha centenas de opgdes além
das fontes padrio. O problema é o mesmo de sempre: o suporte ¢
implementagdo da tag @jfont-face ainda engatinha. E, como o
Typekit ainda ¢ novo, hé algumas questdes técnicas que precisam
ser resolvidas. O futuro, entretanto, parece ser brilhante. Logo a
tipografia na Web serd linda e editével.

Revista www.com.br, ano 10, n° 117, ed. Europa,
abr./2010, p. 82 (com adaptagdes).

Tendo como referéncia o texto acima e a multiplicidade de aspectos
que ele evoca, julgue os itens a seguir.

101 Existem tags CSS que garantem que uma fonte possa ser
escolhida dentro de um conjunto esperado, utilizando fontes de
sistemas e fontes mais utilizadas. Embora essa solugdo ndo seja
ideal, ela permite que a troca de fonte em computadores
remotos seja controlavel e o leiaute de uma pagina web néo
seja totalmente destruido.

102 O designer que adotar imediatamente o uso da tag descrita no
texto pode produzir um sitio nfo acessivel uma vez que o néo
reconhecimento do comando por todos os navegadores
impediria a exibic¢@o da fonte e, portanto, do texto.

103 Até a invengdo do Typekit, nfio existia nenhuma possibilidade
de hospedar fontes na Web.

O autor Jakob Nielsen desenvolve ha mais de uma década estudos
sistematicos acerca de navegabilidade, acessibilidade e usabilidade
na web. Considerando o pensamento de Jakob Nielsen arespeito de
usabilidade, julgue os préximos itens.

104 A capacidade de navegacdo em um sitio é importante para a
usabilidade, sendo que as agdes de buscar e localizar sdo
responsaveis por mais de um ter¢co das dificuldades dos
USUArios.

105 Localizabilidade, design de péagina, informacfio, suporte a
tarefas e design espalhafatoso sfo itens que podem interferir na
acessibilidade de uma pégina web, ao contrario dos bugs.

106 A férmula elaborada para calcular o placar total de problemas
de usabilidade ¢ representada pela expressdo
TFP x TI x /TP /410 , em que TFP, Tl e TP correspondem,
respectivamente, a taxa de frequéncia do problema, taxa de
impacto e taxa de persisténcia.

107 Com relagdo a tipografia e legibilidade, o tamanho de texto
recomendado para o piblico em geral € de 12 a 14 pixels.

Acerca da elaboragdo de uma pagina web, julgue os itens
subsequentes.

108 Um leiaute de pagina web em tabela ¢ mais leve e mais
acessivel do que em CSS.

109 HTML, CSS, SVG e XML sfo linguagens e extensdes
denominadas web standards.

110 O sistema hexadecimal de cores ¢ a converséo de cores de luz
RGB em cores de impressio CMYK e se expressa por
combinagdes de dois digitos, letras e numeros, para cada uma
das cores basicas que compde uma cor.

111 Ao criar-se um arquivo CSS, é possivel declarar nele as
principais caracteristicas de uma pagina e chamar cada um dos
estilos definidos no codigo HTML.

O W3C — Consorcio World Wide Web — ¢ uma comunidade
internacional que desenvolve padres paraa WWW com o objetivo
de garantir o crescimento da Web. Considerando os padrdes do
W3C, julgue os itens que se seguem.

112 A principal fungdo da WAI (web accessibility initiative) ¢
tornar a Web acessivel para as pessoas com deficiéncia.

113 Para a avalia¢fo de acessibilidade de sitios na Web, o W3C
disponibiliza em sua pagina um formulario no qual se pode
digitar o enderego-teste de um sitio e, apds aguardar alguns
instantes, obter um relatério de acessibilidade e um selo de
sitio acessivel.

114 A extensdo de arquivo .svg, gerada em software como o
Inkscape, é indicada pelo W3C para publicagfo de vetores na
Web.

115 Gréficos, codigo HTML e animagdes em .swf estdo entre os
padrdes indicados para web design.

Poder usar a voz em computadores € mais especificamente na web
¢ o sonho de muitos. Recentemente, Alfred Spector, pesquisador do
Google, declarou que estdo nascendo no Google Labs sistemas de
busca por voz. Segundo ele, a voz é um dos maiores desafios
tecnoldgicos em ciéncia da computagdo. Entretanto, para algumas
pessoas, mais que desafio tecnologico, a possibilidade de traduzir
um texto visual em som ¢ a unica forma de ter acesso aos conteudos
publicados na Internet. Com referéncia a essas informagdes e a
leitores de tela, julgue os itens a seguir.

116 Um leitor de tela funciona traduzindo textos e imagens em
som.

117 Considerando-se todas as informag¢des necessarias, a adogdo
dos pardmetros de HTML e CSS e a elaboragio do script das
paginas permitem melhor identificagdo dos elementos e
facilitam o trabalho de um leitor de tela. Um exemplo disso €
0 uso da tag <i mag alt= “breve descricdo da
imagem”>.

118 Atualmente, o sistema IBM Via Voice é o tnico leitor de tela
em portugués disponivel para deficientes visuais.

119 Um leitor de tela que traduza os textos com a voz mais
proximo da humana, evitando efeitos robdticos, diminui o
estresse do usudrio.

120 Um exemplo de uso de fag correto e sua interpretag@io pelos
leitores de tela sdo as tags <b> e <strong>. Embora ambas
produzam como efeito visual uma letra em negrito, a tag
strongacompanhadada codificagdo vocs #7869 significa ler
com mais for¢a ou énfase.
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